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概要
Windows Storage Server 2016 は、高レベルのパフォーマンスと信頼性を実現する高機能ストレージおよびファイル サービス ソリューションです。
Windows Storage Server 2016 OS（オペレーティング システム）を実行する Dell NAS（Network Attached Storage）システムは、コスト パフォーマ
ンスに優れ、ストレージ ソリューションの管理も容易です。

2016 の新しい特徴と機能を確認するには、https://technet.microsoft.com/en-us/windows-server-docs/storage/whats-new-file-storage-

services-windows-server-2016 にアクセスしてください。

トピック：

• iSCSI 導入
• サポートするハードウェアおよびソフトウェア
• お使いのシステムに事前インストールされた役割およびサービス設定

iSCSI 導入
Windows Storage Server では、iSCSI Software Target が Server Manager に統合されています。Server Manager で iSCSI にアクセスするには、
File and Storage Services をダブルクリックします。

iSCSI Software Target は次の機能を提供します。

• ディスクレスネットワークブート機能
• 継続的な可用性設定
• OS ストレージでのコスト削減
• よりセキュアで管理が容易な制御された OS イメージ
• 迅速なリカバリ
• データを破損から保護
• Windows iSCSI イニシエータ以外のイニシエータをサポートする異種ストレージ
• Windows Server を実行するシステムのネットワークアクセスが可能なブロックストレージデバイスへの変換

メモ: NX NAS システム用に iSCSI Target Server を設定する方法の詳細については、https://technet.microsoft.com/en-us/library/

hh848268 を参照してください。

サポートするハードウェアおよびソフトウェア
Microsoft Windows Storage Server 2016 オペレーティング システムを実行する Dell NX シリーズ システムは次のとおりです。

Windows エディション サポートする Dell EMC システム

Microsoft Windows Storage Server 2016、Standard Edition、x64 NX3340、NX3240、NX440、NX430

Microsoft Windows Storage Server 2016、Workgroup Edition、x64 NX440、NX430

お使いのシステムに事前インストールされた役割およびサー
ビス設定
所属組織の要件に基づいて、サーバ役割、役割サービス、および機能がシステムに事前にインストールおよび設定されます。
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役割と役割サービス
事前インストールされている役割と役割サービスは次のとおりです。

ファイルサービスと記憶域サービス ファイルサーバーとストレージを管理します。

ファイルサービスと iSCSI サービス NFS プロトコルを使用して、ファイルサーバーとストレージの管理、ファイル
のレプリケーションとキャッシュ、ディスク容量使用率の削減、およびファイル
の共有を行います。

ファイルサーバー 共有フォルダを管理し、ユーザーがネットワークからシステム上のファイルにア
クセスすることを可能にします。

データ重複排除 ボリュームレベルで機能し、モードデータを少ない物理ディスク容量に保存
します。データ重複排除は重複したデータチャンクを識別し、各チャンクの
単一コピーを維持します。冗長コピーが単一コピーの参照に置き換わりま
す。

DFS 名前空間 異なるサーバにある共有フォルダーを 1 つ、または複数の論理的に構築さ
れた名前空間にグループ化します。

DFS レプリケーション 複数サーバー上のフォルダを、ローカルまたはワイドエリアネットワーク
（WAN）接続を介して同期化します。

ファイルサーバーリソースマネージャ（FSRM） タスクおよびストレージレポートのスケジュール、ファイルの分類、クォータの
設定、およびファイルスクリーンポリシーの定義を行うことによって、ファイルサ
ーバー上のファイルとフォルダを管理します。

ファイルサーバー VSS エージェントサービス ファイルサーバーにデータファイルを保存するアプリケーションのボリュームシャ
ドウコピーを実行します。

iSCSI ターゲットサーバー iSCSI ターゲットにサービスと管理を提供します。

iSCSI ターゲットストレージプロバイダ（VDS および VSS ハードウェアプロバ
イダ）

iSCSI ターゲットに接続されたサーバー上のアプリケーションが、iSCSI 仮想
ディスク上のデータのボリュームシャドウコピーを実行することを可能にしま
す。

NFS 用サーバー UNIX ベースのシステム、および NFS プロトコルを使用するその他のシステ
ムとファイルを共有します。

ワークフォルダ ワーク ファイルにネットワーク内部から、またはインターネットからアクセスする
かに関わらず、ユーザーがさまざまなデバイスからワーク ファイルにアクセスで
きるようにし、それらを同期化された状態に保ちます。

記憶域サービス ストレージ管理機能を提供します。

外観
事前インストールされている機能は次のとおりです。

.NET Framework 3.5（.NET 2.0 と 3.0 を含む）および 4.5 機能 Windows Communication Foundation（WCF）アクティブ化サービスを
使用する機能で、HTTP または TCP プロトコルを使用することによって、
ネットワーク上でアプリケーションをリモートに呼び出します。

マルチパス I/O Windows で、ひとつのストレージデバイスへの複数データパスの使用に対
するサポートを提供します。
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Remote Server Administration Tools（RSAT） 役割と機能をリモートで管理します。

SMB/CIFS ファイル共有のサポート ファイル共有プロトコルおよびコンピュータブラウザプロトコルをサポートしてい
ます。

Windows PowerShell（Windows PowerShell 5.1、2.0 エンジンおよび 
PowerShell ISE を含む）

何百もの組み込みコマンドによってローカルおよびリモート管理を自動化し
ます。

WoW64 サポート Server Core インストールでの 32 ビットアプリケーションの実行をサポートし
ます。
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NAS システムの設定
初期設定後、サーバ マネージャーを使用して役割、役割サービス、および機能を設定します。

NAS システムの初期設定
NAS システムの初期設定には、システムのケーブル配線、電源投入、および Server Manager を使用したシステムの設定が含まれます。NAS システ
ムの設定を完了するには次の手順を実行します。
このタスクについて

メモ: NX シリーズ システムは BIOS モードのみをサポートします。UEFI モードではシステムがアプライアンス OS をロードできないため、起動モ
ードを UEFI に変更しないでください。

手順
1 Windows Storage Server 2016 を実行している NAS システムを起動します。初めて起動したときは、デフォルト パスワード画面で OK をクリックし

ます。

メモ: パスワードを変更する前に、システム言語をご希望に応じて変更するようにしてください。
お使いのシステムは、デフォルトのユーザー名 administrator およびパスワード Stor@ge! で設定されています。

2 管理者パスワードを変更するには、Ctrl+Alt+Delete キーを押して、パスワードの変更 をクリックします。
初回ログイン時には、サーバーマネージャー が自動的に起動します。

3 サーバーマネージャー で、このローカルサーバーの構成 をクリックし、次を行います。
• コンピュータ名の変更
• ドメインの指定
• Windows の最新アップデートのチェック
• タイムゾーンの指定
• リモートデスクトップの設定

メモ: 特定のアプリケーションに移動するには、画面の左下隅をクリックして、スタート アイコンを探します。
4 デフォルト言語を変更するには、C:\Dell_OEM\MUI に移動してから、適切な言語バッチファイルを実行します。画面上の指示に従って、ご希望の

言語をインストールしてください。

サーバーマネージャーの役割、役割サービス、および機能
サーバーマネージャーは、物理的アクセスや、リモートデスクトッププロトコル（RDP）接続なしでデスクトップからリモートおよびローカルサーバーを管理する
管理コンソールです。

システムマネージャーでは次が可能です。

• サーバープールにリモートサーバーを追加する。
• サーバーグループを作成または編集する（特定の目的、または地理的位置のため）。
• 役割、役割サービス、および機能をインストールまたはアンインストールし、ローカルまたはリモートサーバーを表示または変更する。
• お使いのサーバと役割のステータスをリモートで取得する。
• サーバ ステータスを使用して、重大イベントの識別、設定問題や不具合の分析とトラブルシューティングを行う。

2
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• サーバーマネージャー ダッシュボードに表示されるイベント、パフォーマンスデータ、サービス、および Best Practices Analyzer（BPA）結果をカスタマ
イズ。

• タスクを複数サーバーで一斉に実行する。

サーバーマネージャーの起動と終了
サーバーマネージャーは、管理者がシステムにログインするとデフォルトで起動します。サーバーマネージャーを終了する場合は、次のいずれかのタスクを
実行して再起動します。

• タスクバーで、サーバーマネージャー をクリックします。
• スタート 画面で サーバーマネージャー をクリックします。
• Windows PowerShell 環境のコマンド プロンプトで servermanager （大文字と小文字を区別）と入力します。

サーバーマネージャー を終了するには、サーバーマネージャー ウィンドウを閉じます。

サーバーマネージャー役割、役割サービス、および機能のイ
ンストールまたはアンインストール
Windows Storage Server で、Server Manager コンソールと Windows PowerShell cmdlet を使用して、役割、役割サービス、および機能をインス
トールします。複数の役割と機能は、Add Roles and Features Wizard または Windows PowerShell セッションを使用することでインストールできま
す。

メモ: Add Roles And Features Wizard および Windows PowerShell cmdlet の詳細については、technet.microsoft.com/en-us/library/

hh831809.aspx#BKMK_installarfw を参照してください。

NAS システム用の管理ツールへのアクセス
多くの Microsoft 管理コンソール（MMC）スナップインは、管理ツール フォルダにリストされています。
次のいずれかの方法で、管理ツール フォルダーにアクセスします。

• サーバ マネージャーで、ツールをクリックします。
• Windows のロゴキーをクリックします。スタート メニューで 管理ツール タイルをクリックします。
• スタート メニューで コントロールパネル をクリックして、システムとセキュリティ 管理ツール の順にリックします。

コンピュータの管理へのアクセス
コンピューターの管理ツールにアクセスするには、サーバ マネージャーで、ツールコンピューターの管理の順に進みます。コンピューターの管理ウィンドウ
には、システム ツール、ストレージ、およびサービスとアプリケーションの各グループに分類されたツール オプションが表示されます。

システムツール
タスクスケジューラ システムが特定の時刻に自動的に実行する基本タスクの作成と管理に使用されます。作成されたタスクはタスク スケジューラ

ー ライブラリに保存されます。また、タスク ステータスおよび失効していないアクティブなタスクも追跡します。

イベントビューア カスタム ビューを作成またはインポートし、特定のノードやログで発生したイベントを表示するために使用されます。また、管理
ログの概要、最近表示されたノード、およびログ概要も表示されます。

共有フォルダー システム上のファイル共有を一元的に管理するために使用されます。共有フォルダーでは、オープン ファイルとユーザーの表示と
管理の他、ファイル共有の作成、および許可の設定を行うことができます。
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ローカルユーザーとグ
ループ

コンピューター上にローカルに保存されたユーザーとグループの作成と管理に使用されます。

パフォーマンス リアルタイム、またはログを使用してパフォーマンスを監視するために使用されます。結果を分析し、レポートを表示するため、設
定データが収集され、イベントがトレースされます。

デバイスマネージャ ハードウェアの取り付け、およびそのハードウェアが Windows OS と通信できるようにするデバイスドライバソフトウェアをサポート
するテクノロジを管理します。

ストレージ
Windows Server バッ
クアップ

毎日のバックアップおよびリカバリ要件のために、コマンド ライン インターフェイス（CLI）と Windows PowerShell cmdlet を使
用する機能です。データのバックアップは、ローカルおよびオンラインで実行できます。Windows Server Backup を実行するに
は、Windows Server バックアップ機能をインストールしてください。

ディスクの管理 ハード ディスク ドライブと、それらに含まれるボリュームまたはパーティションを管理するためのシステム ユーティリティです。ディスク
の管理では、仮想ディスクの作成と連結、ディスクの初期化、ボリュームの作成、および FAT、FAT32、または NTFS ファイル 
システムでのボリュームのフォーマットを行うことができます。また、システムを再起動したりユーザーの作業を中断したりすることな
く、ほとんどのディスク関連タスクを実行するためにも役立ちます。大半の設定変更はただちに適用されます。

サービスとアプリケーション
ルーティングとリモート
アクセスサービス

Direct Access、ルーティング、およびリモート アクセスの 3 つのネットワーキング サービスを 1 つの統合サーバ ロールに組み合わ
せるテクノロジーです。

サービス ファイル サービス、イベント ログなど、ローカルまたはリモート コンピューターで実行されるサービスの管理に使用されます。サービ
スは sc config コマンドを実行して管理することもできます。

ワークフォルダ
ワークフォルダは、ユーザーが個人のシステムまたは、個人のデバイス持参（bring-your-own-device、BYOD） と呼ばれる、任意の場所からワークデバ
イスでファイルを保存したりアクセスしたりすることを可能にします。ワークフォルダは、フォルダリダイレクション、オフラインファイル、ホームフォルダの既存の展
開を含めて展開できます。ユーザーファイルは、同期共有と呼ばれるサーバー上のフォルダに保存されます。ワークフォルダの詳細については、
technet.microsoft.com/en- us/library/dn265974.aspx にアクセスしてください。

ワークフォルダのインストール
ワーク フォルダーをインストールするには、次の手順を実行します。

1 Server Manager で、Manage > Add Roles and Features の順にクリックします。
役割と機能の追加ウィザード が表示されます。

2 次へ をクリックします。

メモ: 開始する前に ウィンドウで、インストールする役割と機能の対象サーバーとネットワーク環境を確認してください。
3 Select installation type ウィンドウで、次のいずれかを選択し、Next をクリックします。

• 役割または機能の全部分をインストールする場合は、Role-based or feature-based installation
• 仮想マシンベースのデスクトップ インフラストラクチャ、またはリモート デスクトップ サービス用のセッションベースのデスクトップ インフラストラクチャを

インストールする場合は、Remote Desktop Services installation

4 Select destination server ウィンドウで、サーバ プールからサーバを選択するか、Windows Storage Server がすでにインストールされているオフラ
イン仮想ハード ディスク（VHD）を選択し、Next をクリックします。
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5 Select Server Roles ウィンドウで、File and Storage Services > File and iSCSI Services > Work Folders の順にクリックします。
ワークフォルダに必要な機能を追加します というダイアログボックスが表示されます。

6 ワークフォルダのインストールに追加機能が必要な場合は、機能の追加 をクリックして続行し、次へ をクリックします。
7 ワークフォルダ ウィンドウで概要情報を確認し、次へ をクリックします。
8 インストールオプションの確認 ウィンドウで情報メッセージをすべて読み、インストール をクリックします。
9 インストールが正常に完了したことを確認するには、インストール結果 ウィンドウを確認します。
10 閉じる をクリックしてウィザードを終了します。

ワークフォルダ の役割は、 サーバーマネージャー > ファイルサービスと記憶域サービス フォルダ内に作成されます。

ワークフォルダの同期共有の作成
ワーク フォルダーの同期共有を作成するには、次の手順を実行します。

1 Server Manager で、File and Storage Services > Work Folders の順にクリックします。
ワークフォルダのページに、ユーザー、ボリュームおよびクォータペインが表示されます。

2 同期共有を作成するには、ワークフォルダセクションで次のタスクのいずれかを実行します。
• To create a sync share for Work Folders, start the New Sync Share Wizard をクリックします。
• タスクドロップダウンメニューから新しい同期共有を選択します。

新しい同期共有ウィザードウィンドウが表示されます。
3 画面の指示に従って、ワークフォルダの同期共有を作成します。ワークフォルダの導入の詳細については、technet.microsoft.com/en-us/

library/dn528861.aspx#step3 にアクセスしてください。

新しい DFS 名前空間の作成
新しい DFS 名前空間を作成するには、次の手順を実行します。

1 Server Manager で、Tools > DFS Management の順にクリックします。
DFS の管理 ウィンドウが表示されます。

2 アクション で、新しい名前空間 をクリックします。
新しい名前空間ウィザード が表示されます。

3 新しい名前空間ウィザード のタスクを完了し、ウィザードを閉じます。

メモ: サーバーがオフの場合、名前空間サーバーは作成できません。

新しい DFS レプリケーショングループの作成
新しい DFS レプリケーショングループを作成するには、次の手順を実行します。

1 Server Manager で、Tools > DFS Management の順にクリックします。
DFS の管理 ウィンドウが表示されます。

2 アクション で、新しいレプリケーショングループ をクリックします。
新しいレプリケーショングループウィザード が表示されます。

3 新しいレプリケーショングループウィザード のタスクを完了し、ウィザードを閉じます。
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ディスプレイへの DFS 名前空間の追加
ディスプレイに DFS 名前空間を追加するには、次の手順を実行します。

1 Server Manager で、Tools > DFS Management の順にクリックします。
DFS の管理 ウィンドウが表示されます。

2 アクション で、ディスプレイへの DFS 名前空間の追加 をクリックします。
ディスプレイへの DFS 名前空間の追加 ウィンドウが表示されます。

3 スコープ で 参照 をクリックし、親ドメインを探します。
4 名前空間の表示 をクリックし、親ドメイン上の名前空間を選択します。OK をクリックします。

DFS 管理に名前空間が \\parentdomain\rootname 形式で表示されます。

ディスプレイへのレプリケーショングループの追加
ディスプレイにレプリケーショングループを追加するには、次の手順を実行します。

1 Server Manager で、Tools > DFS Management の順にクリックします。
DFS の管理 ウィンドウが表示されます。

2 アクション で、ディスプレイへのレプリケーショングループの追加 をクリックします。
ディスプレイへのレプリケーショングループの追加 ウィンドウが表示されます。

3 参照 をクリックして親ドメインを探します。
4 レプリケーショングループの表示 をクリックし、親ドメイン上のレプリケーショングループを選択します。OK をクリックします。

DFS 管理にレプリケーショングループが \\parentdomain\rootname 形式で表示されます。

ファイルサーバーリソースマネージャ
ファイル サーバ リソース マネージャー（FSRM）は、Windows Storage Server 用ツール群で、管理者がシステムに保存されたデータの量とタイプを把
握、制御、および管理できるようにするものです。管理者は FSRM を使用して、フォルダーとボリュームへのクォータの設定、アクティブなファイル スクリー
ン、および包括的なストレージ レポートの生成を行うことができます。これらのツールは、管理者による既存のストレージ リソースの効率的な監視だけで
なく、将来的なポリシー変更の計画および実装にも役立ちます。FSRM タスクには次が含まれます。

• クォータ管理
• ファイルスクリーニング管理
• ファイル管理タスク
• ストレージレポート管理
• 分類管理

マルチパス I/O
Microsoft マルチパス I/O（MPIO）は、Microsoft によって提供されるフレームワークで、ストレージ プロバイダーによるハードウェア固有の情報を含むマ
ルチパス ソリューションの開発を可能にします。これらのモジュールは Device-Specific Module（DSM）と呼ばれます。MPIO はプロトコル非依存で、
Windows Server OS の Fibre Channel、インターネット SCSI（iSCSI）、および Serial Attached SCSI（SAS）インターフェイスで使用することができま
す。MPIO は、ストレージ アレイへの接続性を最適化するのに必要です。

MPIO は次の機能を提供します。

• フェールオーバークラスタリングによるアプリケーションの高可用性
• ストレージアレイに対する高可用性
• SAS ディスク互換性
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• Windows PowerShell コマンドレットを使用して MPIO タスクを実行する機能

メモ: Microsoft 提供の DSM で作業するには、ストレージが SCSI Primary Commands-3 （SPC-3）対応である必要があります。

MPIO でのデバイスの追加
MPIO でデバイスを追加または削除するには、次の手順を実行します。

1 サーバ マネージャーで、［ツール］［MPIO］の順にクリックします。
MPIO のプロパティ ウィンドウが表示されます。

2 MPIO デバイス タブで 追加 をクリックし、MPIO サポートを追加するデバイスの デバイスハードウェア ID を入力して、OK をクリックします。
3 デバイス ハードウェア ID が Discover Multi-Paths タブにリストされます。

メモ: デバイスのハードウェア ID は、ベンダー名と、MPIO の対応デバイスリスト内に MPIO によって維持されているデバイス ID と一
致する製品文字列の組み合わせです。ベンダーおよび製品 ID はストレージプロバイダによって提供され、各種ハードウェアに固有で
す。

4 DSM インストール タブで DSM INF ファイルを入力し、インストールまたはアンインストール をクリックして DSM をインストール / アンインストールし
ます。

5 構成のスナップショット タブで、システム上の現在の MPIO 構成のスナップショットをキャプチャし、キャプチャされる情報のためのファイル名を指定し
て キャプチャ をクリックします。
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NAS システムの管理
次の管理ツールはお使いのシステムにインストール済みです。

• Dell EMC OpenManage Server Administrator

• 管理用リモートデスクトップ

メモ: NX シリーズ システムは BIOS モードのみをサポートします。UEFI モードではシステムがアプライアンス OS をロードできないため、起動モ
ードを UEFI に変更しないでください。

トピック：

• Dell EMC OpenManage Server Administrator

• 管理用リモートデスクトップ
• DVD を使用した NAS オペレーティング システムの再インストール

Dell EMC OpenManage Server Administrator
Dell EMC OpenManage Server Administrator は、次の 2 つの方法で包括的な一対一のシステム管理ソリューションを提供します。

• 統合的なウェブブラウザベースのグラフィカルユーザーインタフェース（GUI） — Server Administrator ホームページからの管理
• コマンドラインインタフェース（CLI） — OS からの管理

Server Administrator は、ネットワークの NAS システムをローカルおよびリモートで管理することを可能にします。

Server Administrator は次の情報を提供します。

• 正常に動作しているシステムと問題があるシステム
• アップデートが必要なシステム
• リモートリカバリ操作が必要なシステム

メモ: Dell EMC OpenManage Server Administrator の詳細については、Dell.com/openmanagemanuals で関連するバージョンの『Dell 
EMC OpenManage Server Administrator ユーザーズ ガイド』を参照してください。

管理用リモートデスクトップ
管理用リモート デスクトップ（旧称：リモート管理モードのターミナル サービス）を使用して、ストレージ システムをリモートで管理することができます。ター
ミナル サービス テクノロジーをベースとした管理用リモート デスクトップは、サーバ管理用に設計されたものです。

メモ: 管理用リモートデスクトップは、サーバーにアクセスするクライアントコンピュータに特別なライセンスを購入する必要がありません。管理の
ためにリモートデスクトップを使用するときにターミナルサーバーライセンスをインストールする必要もありません。

次のツールのいずれかを使用して、管理用リモート デスクトップでサーバにリモート ログインすることができます。

• リモートデスクトップ接続
• リモートウェブ管理
• Microsoft Windows Server リモート管理アプレット

メモ: Dell EMC では、セキュアな接続のために、サーバ用の証明書を取得し、HTTPS 接続を使用して Windows Storage Server に接続す
ることをお勧めします。

3
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リモートデスクトップ接続のアクティブ化
リモート デスクトップ接続をアクティブ化するには、次の手順を実行します。

1 サーバーマネージャー で ローカルサーバー をクリックします。
2 Properties ウィンドウで、Remote Desktop オプションの横にある Enabled リンクをクリックします。

Windows Storage Server では、リモート管理がデフォルトで有効化されています。

システムのプロパティ ウィンドウが表示されます。
3 Remote タブの Remote Desktop セクションで、Allow remote connections to this computer を選択します。

メモ: ネットワーク レベル認証を持つリモート デスクトップがシステムへの接続を許可されます。
4 Select Users をクリックします。

リモートデスクトップユーザー ウィンドウが表示されます。
5 Add または Remove をクリックしてユーザーにアクセス権を付与し、OK をクリックします。
6 適用、OK の順にクリックします。

リモートデスクトップ接続の作成と保存
Windows Storage Server へのリモート デスクトップの接続を作成して保存するには、次の手順を実行してください。

1 タスクバーで、Start をクリックし、検索ボックスに Run と入力してから Enter を押します。
ファイル名を指定して実行 ダイアログボックスが表示されます。

2 ファイル名を指定して実行 ダイアログボックスに、MSTSC と入力して OK をクリックします。
リモートデスクトップ接続 ウィンドウが表示されます。

3 Remote Desktop Connection ウィンドウで、ストレージ システムのコンピューター名または IP アドレスを入力し、Options をクリックします。
接続設定 ウィンドウが表示されます。

4 リモートデスクトップ接続 ウィンドウの 接続設定 ダイアログボックスで、名前を付けて保存 をクリックします。
名前を付けて保存 ウィンドウが表示されます。

5 ファイル名 にその接続用の名前を入力し、拡張子は.rdp のままにしておきます。
6 保存先 ドロップダウンメニューで デスクトップ を選択し、保存 をクリックします。

リモートデスクトップ接続の設定の詳細については、リモートデスクトップ接続 ウィンドウの ヘルプ をクリックしてください。

DVD を使用した NAS オペレーティング システムの再インス
トール
新しい OS ドライブに NAS オペレーティング システムを再インストールする場合は、新しいドライブにパーティションを作成する必要もあります。このセクショ
ンでは、新しい OS ドライブのパーティションを再作成する方法と、NAS オペレーティング システムを再インストールする方法について説明します。

注意: NAS オペレーティングシステムの再インストールまたはアップグレードを行う前に、お使いのシステムの内蔵ディスクドライブをバックアップ
してください。この DVD 再インストールプロセスは、OS ディスク（仮想ディスク 0）をフォーマットまたは削除するため、あらゆるデータまたはイ
ンストール済みアプリケーションが失われることになります。DVD 再インストールプロセスは、RASR USB Recovery アプリケーションをインスト
ールしません。

標準 RAID 構成は、システムによって異なります。

• NX430：OS のみ – RAID 5
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• NX440：OS のみ – RAID 5

• NX3240：OS HDD – RAID 1（背面 2.5 インチ HDD）

• NX3340：OS のみ – RAID 1（HDD x 2）または RAID 5（HDD x 4）

お使いの固有の RAID 構成の詳細については、元の出荷時の構成を参照してください。

OS パーティションのリカバリ
破損した OS パーティションをリカバリするには、次の手順を実行します。
前提条件

• 故障した OS ドライブが新しい空の HDD に置き換えられました。

注意: データ ドライブまたはそれらに関連した物理ドライブ上にある元のパーティションを削除しないでください。

手順
1 システムの電源を入れるか再起動し、F2 を押して、System Setup から起動します。
2 デバイス設定をクリックします。
3 Integrated RAID Controller 1: Dell PERC <PERC H730P Mini> Configuration Utility をクリックします。
4 Configuration Utility メニューで、Virtual Disk Management をクリックします。
5 次の点を確認します。

• 元のデータ パーティションまたはパーティションが表示されます
• OS パーティションは表示されません

6 データ パーティションを変更せずに Back をクリックします。
7 Configuration Utility で Create Virtual Disk をクリックします。
8 Create Virtual Disk ダイアログ ボックスで、RAID Level および Capacity オプションを選択します。

• Select RAID Level — 上記の標準 RAID 構成を参照してください。
• Select Physical Disks From — 未設定容量。

9 Select Physical Disks をクリックして、RAID を構成するドライブを選択します。
10 変更の適用 をクリックします。
11 Success 画面に The operation has been performed successfully と表示されたら、OK をクリックします。
12 Create Virtual Disk Parameters で、次のオプションを設定し、残りのオプションをデフォルト設定のままにします。

• Virtual Disk Name — OS などの一意の名前を入力します
• Virtual Disk Size — GB 単位（現在このパーティションは 140GB）。
• Default Initialization — 高速（例）

13 仮想ディスクの作成 をクリックします。
14 ［Warning］画面で、Confirm を選択し、Yes をクリックします。
15 仮想ディスクが正常に作成されたというメッセージが表示されたら、OK をクリックします。
16 Back を 2 回クリックして、Configuration Utility メイン メニューに戻ります。
17 仮想ディスク管理をクリックします。
18 新たに作成された OS パーティションと既存のデータ パーティションが両方存在することを確認します。
19 Back をクリックして、Configuration Utility メイン メニューに戻ります。
20 Controller Management をクリックします。
21 Select Boot Device で、OS Partition を選択します。
22 Back をクリックして、Configuration Utility メイン メニューに戻り、Finish をクリックします。
23 Finish を再度クリックしてシステムを再起動します。
24 再起動中に F2 を押して、System Setup から起動します。

NAS システムの管理 17



25 System Setup Main Menu で、System BIOS をクリックします。
26 ［System BIOS］オプションで、Boot Settings > BIOS Boot Settings を選択します。
27 Integrated RAID Controller 1：PERC H730P Mini が存在し、ブート オプションとして選択されていることを確認します。
28 必要に応じて変更を保存し、BIOS を終了します。
29 システムを再起動し、F10=Lifecycle Controller を押して、OS の導入に進みます。

Dell Lifecycle Controller を使用した OS の導入
Dell Lifecycle Controller を使用して OS を導入するには、次の手順を実行します。
前提条件

• OS ドライブがインストールされ、パーティション分割されました。
• 外付け USB DVD ROM が使用できます。
• Windows Storage Server 2016 プロダクト キーが使用できます。これは、システム カバーに貼ってあります。

手順
1 まだ完了していない場合、システムを再起動し、F10=Lifecycle Controller を押します。
2 左ナビゲーション ペインで、OS Deployment を選択します。

［OS Deployment］ウィザードが起動します。
3 Select Deployment path ページで、Go directly to OS Deployment を選択し、Next をクリックします。
4 Select an Operating System ページで、次のデフォルト設定を受け入れます。

• Boot Mode — BIOS

• Secure Boot— 無効
• Secure Boot Policy — 標準
• Available Operating Systems — Microsoft Windows Server 2016

5 次へ をクリックします。
システムが OS ドライバをアセンブルします。このプロセスにかかる時間は 5 分未満です。

6 Select Installation Mode ページで、Manual Install を選択し、Next をクリックします。
OS Media ページが表示されます。

7 Windows Storage Server 2016（ワーク グループまたは標準）の DVD 再インストール メディア ディスクを外付けドライブに挿入し、Next をクリック
します。
システムが OS メディアの検証を実行し、Reboot the System ページを開きます。

8 選択を確認して、Finish をクリックします。
9 プロンプトが表示されたら、任意のキーを押して、オペレーティング システム メディアから起動します。

システムが再起動して、オペレーティング システムのインストール ウィザードが始まります。
10 言語の選択ページで、該当する言語を選択し、Next をクリックします。
11 Install Now を選択し、Next をクリックします。
12 製品のアクティベーション ページで、プロダクト キーを入力し、Next をクリックします。
13 ライセンス同意ページで、I accept the license terms を選択して、Next をクリックします。
14 次のページで、Custom: Install the newer version of Storage Server only（advanced）を選択します。
15 Where do you want to install Storage Server?オプションで、OS パーティションのリカバリ手順で作成した［140 GB drive］を選択します。

メモ: OS インストールに既存のデータ ドライブを選択しないでください。選択したドライブがこの目的のために作成された新しい OS

ドライブであることを確認してください。
16 OS Target-Drive オプションで、Unallocated Space（デフォルト）を選択し、Next をクリックします。

インストールが開始し、終了までに 60～90 分かかります。発生したエラーは、お使いのデバイスの前面パネル LCD でフラグされます。
17 製品の『インストールおよびサービス ガイド』で説明されている初期設定手順を完了して、インストールを終了します。
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dell.com/support にアクセスし、必要に応じてドライバや OpenManage Server Administrator ソフトウェアをダウンロードします。
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NAS システムの使い方
サーバーメッセージブロック共有の作成
Windows Storage Server 2016 または 2012 R2 には、SMB（Server Message Block）3.0 プロトコルが導入されています。このプロトコルは、アプリケ
ーションがファイルに対して読み取りおよび書き込みを行うことを可能にし、ネットワーク内のサーバ プログラムからサービスをリクエストするネットワーク ファイ
ル共有プロトコルです。SMB ファイル共有は、ユーザー データベース ファイルを保存し、VM またはデータベースを動的に移行することもできます。サーバ 
マネージャーを使用して SMB 共有を作成するには、次の手順を実行してください。

1 Server Manager で、File and Storage Services > Shares の順にクリックします。
共有、ボリューム および クォータ ペインがあるページが表示されます。

2 共有を作成するには、共有セクションで次のタスクのいずれかを実行します。
• 共有ファイルの作成のために、新しい共有ウィザードを起動 リンクをクリックします。
• タスク ドロップダウンメニューから 新しい共有 を選択します。

新しい共有ウィザード ページが表示されます。
3 この共有のプロファイルの選択 ウィンドウで、要件に応じてファイル共有プロファイル（SMB 共有 – 簡易、詳細またはアプリケーション）のチェッ

クボックスを選択し、次へをクリックします。
4 この共有のサーバーとパスの選択 ウィンドウで、新しい共有のサーバー名および共有の場所を選択し、次へ をクリックします。

共有の場所はボリューム、またはカスタムパスを入力することで選択できます。
5 共有名の指定 ウィンドウで、共有名および共有の説明を入力し、次へ をクリックします。

共有フォルダが存在しない場合は、共有へのローカルパスがフォルダを自動的に作成します。
6 共有設定の構成 ウィンドウで必要な設定を選択し、次へ をクリックします。
7 アクセスを制御する許可の指定 ウィンドウで、必要に応じてあらゆる組み合わせのフォルダ許可を設定し、次へ をクリックします。
8 選択内容の確認 ウィンドウで設定を確認し、作成 をクリックします。

結果の表示 ウィンドウに正常な共有の作成が表示されます。
9 閉じる をクリックしてウィザードを終了します。

新しく作成された SMB 共有フォルダは Windows ベースのクライアントからアクセスすることができます。

メッセージブロック共有の変更
既存共有のプロパティを変更するには、次の手順を実行します。

1 Server Manager で、File and Storage Services > Shares の順にクリックします。
2 共有 セクションから共有を選択します。
3 右クリックして、プロパティ を選択します。

<共有名> のプロパティ ウィンドウが表示されます。
4 共有のプロパティを変更するための一般、許可、設定、および管理プロパティ といった異なるタブをクリックできます。

NFS 共有
ネットワークファイルシステム（NFS）プロトコルは、アクセス制御（UNIX ベースのファイルシステム用）を提供し、ネットワーク名を使用して特定のクライ
アントシステムおよびグループに許可を与えることによって実装されます。

4
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NFS 共有を作成する前に、管理者はアイデンティティマッピングを設定する必要があります。アイデンティティマッピングのソースは次のいずれかにすることが
できます。

• Microsoft Active Directory ドメイン名サーバー（Microsoft Windows Server 2003 ドメインコントローラ、Microsoft Windows Server 2008 ドメ
インコントローラ、または Microsoft Windows Server 2012 ドメインコントローラ、および Microsoft Windows Server 2016 ドメインコントローラ）

• User Name Mapping（UNM）サーバー
• Active Directory Lightweight Directory Services （AD LDS）

関連リンク
NFS 共有の作成

アイデンティティ マッピング ソースとしての Windows ドメイ
ン コントローラー
Dism.exe コマンドを使用して UNIX 用 ID 管理をインストールおよび設定するには、次の手順を実行します。

1 ドメインコントローラで、Windows PowerShell を右クリックし、 管理者として実行 をクリックします。
2 UNIX 用 ID 管理のための管理ツールをインストールするには、次のコマンドを実行して Enter を押します。Dism.exe /online /enable-

feature /featurename:adminui /all

メモ: UNIX 用 ID 管理のインストール後、システムを再起動します。/quiet パラメーターは、インストール完了後にシステムを自動
的に再起動します。

3 NFS クライアント に移動し、ユーザー名、グループ名、UID、 および GID の詳細を書き留めます。
4 ドメインコントローラ に移動します。
5 Active Directory ユーザーとコンピュータ を開き、UNIX ユーザー名とグループを作成します。
6 前記手順で作成したグループにそのユーザーを追加します。
7 新しく作成したユーザーを選択し、プロパティ > UNIX 属性 と進みます。UID、GID、シェル、ホームディレクトリ、およびドメイン詳細（先ほど NFS ク

ライアントから取得）を変更します。
8 新しく作成したグループを選択して GID のチェック（UNIX GID と一致していることを確認）、UNIX プロパティの変更を行い、手順 6 で追加したメン

バーとユーザーを追加して、適用 をクリックします。
9 PowerVault NAS Windows Storage Server 2016（NFS）サーバに移動します。
10 スタート > 管理ツール > ネットワークファイルシステム用サービス とクリックします。
11 Services for NFS を選択します。
12 Properties を右クリックし、アイデンティティ マッピング ソースとして Active Directory domain name を選択します。
13 Windows 2016 のドメイン名を入力し、Apply をクリックします。

アイデンティティマッピングソースとしてのユーザー名マッピン
グサーバー
ユーザー名マッピングをインストールして設定するには、次の手順を実行します。

1 お使いの NAS システムの Server Manager で、Tools > Services for Network File System（NFS）をクリックします。
ネットワークファイルシステム用サービス ウィンドウが表示されます。

2 NFS 用サービス をクリックし、プロパティ を選択します。
NFS 用サービスのプロパティ ウィンドウが表示されます。

3 ユーザー名マッピング をアイデンティティマッピングソースとして選択し、ユーザー名マッピングサーバーのホスト名を入力します。
4 UNM サーバーへ移動してパスワードをコピーし、前の手順で収集したファイルをローカルディスクにグループ化します。
5 Add or Remove Programs > Add Windows Components > Select Other Network File and Print Services の順にクリックします。
6 詳細 をクリックします。
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7 NFS 用 Microsoft サービスを選択して、詳細をクリックし、ユーザー 名 マッピングを選択します。
8 次へ をクリックし、インストールを完了します。

メモ: インストール完了後、システムを再起動してください。
9 NFS クライアントに移動し、/etc/passwd と /etc/group files を取得して、USB ドライブにコピーします。
10 UNM サーバーへ移動し、USB ドライブからローカルハードディスクへ UNIX ファイルをコピーします。
11 NFS 用 Microsoft サービスを開始します。
12 ユーザー名マッピング を選択してから、プロパティ を右クリックします。
13 UNIX ユーザーソース タブへ移動し、パスワード ファイルとグループファイルを使用する オプションを選択します。
14 参照ボタンをクリックし、前の手順でコピーしたパスワードおよびグループファイルを選択します。
15 簡易マッピングタブで、簡易マップを使用するオプションを選択し、適用をクリックします。
16 ユーザーマップ を選択し、マップの作成 を右クリックします。
17 Windows ユーザーの一覧 と UNIX ユーザーの一覧 オプションをクリックします。
18 ユーザーをマップし（1 度に 1 ユーザー）、一覧に追加します。リストされている他のユーザーにも同じ手順を繰り返します。
19 グループマップ > マップの作成 を開きます。
20 Windows および UNIX グループ を一覧表示し、マップしてリストに追加します。
21 .maphosts ファイルを開き（C:\Windows\msnfs および C:\Windows\amd64\cmpnents\r2 で .maphosts ファイルを検索）、NFS サーバー

の詳細（DNS がある場合、IP 4 アドレスまたは ホスト名）を追加して、ファイルを保存します。

アイデンティティ マッピング ソースとしての AD LDS
Active Directory ライトウェイト ディレクトリ サービス（AD LDS）は、ユーザー マッピングをサポートするための Active Directory が存在しない環境で、
Windows Storage Server を実行するシステムでのアイデンティティ マッピングに使用されます。

AD LDS マッピングを開始する前に次を実行します。

• Windows ベースシステムのユーザーおよびグループにマップする必要のある UNIX ベースシステムのユーザーおよびグループを特定。
• 各 UNIX ユーザーの UID と GID 、および各 UNIX グループの GID を特定。
• マップされる各 UNIX ユーザーおよびグループに対し、Windows ベースのコンピュータにユーザーまたはグループを作成。

メモ: 各 UID および GID にはそれぞれ固有のマッピングが必要です。一対多、または多対一マッピングは使用できません。

NFS 用サービスのための AD LDS 設定
NFS 用サービスのために AD LDS を設定するには、次の手順を実行してください。

1 AD LDS サーバーロールをインストール。
2 AD LDS インスタンスを作成します。
3 NFS ユーザーマッピングをサポートするため、AD LDS スキーマを拡張します。
4 AD LDS インスタンスにデフォルトのインスタンス名を設定します。
5 Active Directory スキーマをアップデートします。
6 ユーザーおよびグループアカウントマップを UNIX ベースのコンピュータから Windows ベースコンピュータに追加します。
7 ADS LDS 名前空間オブジェクトへの適切なアクセスを認証します。
8 マッピングソースを設定します。

関連リンク
AD LDS サーバーロールのインストール
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AD LDS サーバーロールのインストール
AD LDS サーバーロールをインストールするには、次の手順を実行します。

1 Server Manager で、Manage > Add Roles and Features の順にクリックします。
役割と機能の追加ウィザード が表示されます。

2 次へ をクリックします。

メモ: 開始する前に ウィンドウで、インストールする役割と機能の対象サーバーとネットワーク環境を確認してください。
3 インストールの種類の選択 ウィンドウで 役割ベースまたは機能ベースのインストール をクリックして役割または機能の全部分をインストール、また

は リモートデスクトップサービスのインストール をクリックして、仮想マシンベースのデスクトップインフラストラクチャ、またはリモートデスクトップサービス
用のセッションベースのデスクトップインフラストラクチャのいずれかをインストールし、次へ をクリックします。

4 Select destination server ウィンドウで、サーバ プールからサーバを選択するか、または Windows Storage Server 2016 がすでにインストールされ
ているオフライン仮想ハード ディスク（VHD）を選択し、Next をクリックします。

5 サーバーロールの選択 ウィンドウで、Active Directory ライトウェイトディレクトリサービス を選択します。
AD LDS に必要な機能を追加しますか? というダイアログボックスが表示されます。

6 AD LDS のインストールに追加機能が必要な場合は、機能の追加 をクリックして続行し、次へ をクリックします。
7 Active Directory ライトウェイトサービス ウィンドウで概要情報を確認し、次へ をクリックします。
8 インストールオプションの確認 ウィンドウで情報メッセージをすべて読み、インストール をクリックします。
9 インストールが正常に完了したことを確認するには、インストール結果 ウィンドウを確認します。
10 閉じる をクリックしてウィザードを終了します。

Active Directory ライトウェイトディレクトリサービス の役割が サーバーマネージャー ダッシュボードページに作成されます。

新規 AD LDS インスタンスの作成
AD LDS インスタンスを作成するには次の手順を実行します。

1 Server Manager で、Tools > Active Directory Lightweight Directory Services Setup Wizard の順にクリックします。
Active Directory ライトウェイトディレクトリサービスセットアップウィザード が表示されます。

2 次へ をクリックします。
3 セットアップオプション ウィンドウで、一意のインスタンス を選択し、次へ をクリックします。
4 インスタンス名 ウィンドウで、インスタンス名 ボックスにインスタンス名を入力し、次へをクリックします。

メモ: 例えば、nfsadldsinstance をインスタンス名として使用できます。
5 ポート ウィンドウで LDAP ポート番号 と SSL ポート番号 を入力し、次へ をクリックします。

メモ: デフォルトの LDAP ポート番号は 389 で、デフォルトの SSL ポート番号は 636 です。
6 アプリケーションディレクトリパーティション ウィンドウで、アプリケーションディレクトリパーティションを作成する オプションを選択します。
7 パーティション名 ボックスには、このインスタンス内にすでに存在していないパーティション名を CN=<Partition>, DC=<Computer name> 

形式で入力します。

メモ: この文字列は、慣例に従って完全修飾ドメイン名に基づいています。例えば、インスタンス名が nfsadldsinstance であ
り、サーバー名が server 1 である場合、パーティション名は CN=nfsadldsinstance, DC=server1 になります。

8 パーティション名を入力したら、次へ をクリックします。
9 ファイルの場所 ウィンドウで、データファイル および データ回復ファイル フィールドに AD LDS に関連するファイルを保存する場所を入力するか参

照し、次へ をクリックします。
10 サービスアカウントの選択 ウィンドウで、Network サービスアカウント を選択して 次へ をクリックします。

メモ: システムがドメインのメンバーではない場合、AD LDS instance cannot replicate data with AD LDS 
instances on other computers while using this service account.というメッセージが表示されます。
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11 続行するには、はい をクリックします。
12 AD LDS 管理者 ウィンドウで、現在ログオンしているユーザー：<ユーザー名> オプションを選択し、次へ をクリックします。
13 LDIF ファイルのインポート ウィンドウで、インポートする .LDF ファイル名を選択し、次へ をクリックします。

メモ: MS-InetOrgPerson.LDF および MS-User.LDF は必須です。
14 インストールの準備完了 ウィンドウの、 選択 の下で、リストされた選択を確認し、次へ をクリックします。

AD LDS サービスのインストールが開始されます。
15 終了 をクリックしてウィザードを終了します。

メモ: AD LDS のインストール後、セットアップ中に問題が発生した場合は、それらが完了ウィンドウにリストされます。
16 アクティブな AD LDS インスタンスが存在することを確認するには、Control Panel > Programs > Programs and Features の順にクリックします。

作成されたすべての AD LDS インスタンスがリストされます。

NFS ユーザーマッピングのサポートのための AD LDS スキー
マの拡張
NFS マッピングをサポートするため AD LDS スキーマを拡張するには、次の手順を実行します。

1 タスクバーで スタート をクリックし、検索ボックスに cmd と入力します。
2 Command Prompt を右クリックし、Run as administrator を選択します。
3 C:\WINDOWS\ADAM ディレクトリに移動し、次のコマンドを入力します。

ldifde -i -u -f MS-AdamSchemaW2K8.LDF -s localhost:389 -j . -c "cn=Configuration,dc=X" 
#configurationNamingContext

このコマンドは MS-AdamSchemaW2K8.LDF ファイルをインポートします。

メモ: この例では、AD LDS インスタンスにデフォルトの LDAP ポート番号 389 が使用されています。文字列
cn=Configuration,dc=X および#configurationNamingContext は変更しないようにしてください。

AD LDS インスタンスにデフォルトのインスタンス名を設定
AD LDS インスタンスにデフォルトインスタンス名を設定するには、次の手順を実行します。

1 サーバーマネージャー で、ツール > ADSI エディタ（Active Directory サービスインタフェース）の順にクリックします。
ADSI エディタ コンソールが表示されます。

2 コンソールで ADSI エディタ を右クリックして 接続 をクリックします。
または、ADSI Edit コンソールで、Actions > More Actions > Connect to の順にクリックします。

接続の設定 ダイアログボックスが表示されます。
a 接続ポイント で、周知のネーミングコンテキストの選択 オプションを選択して、ドロップダウンメニューから 設定 を選択します。
b コンピュータ で ドメインまたはサーバーを選択または入力 オプションを選択し、テキストボックスに localhost:389 と入力します。

メモ: この例ではデフォルト LDAP ポート番号 389 を使用しています。Active Directory ライトウェイトディレクトリサービスセットアッ
プウィザード で異なるポート番号を指定した場合は、かわりにその値を使用します。

3 OK をクリックします。
ADSI エディタ が更新され、新規接続が表示されます。

4 表示されたツリーの 設定 ノードで、CN=Configuration、CN=Sites、CN=Default-First-Site-Name、CN=Servers、CN=server1$ 
nfsadldsinstance、CN=NTDS Settings の順にクリックします。

5 CN=NTDS Settings を右クリックし、プロパティ をクリックします。
6 プロパティ ダイアログボックスで、msDs-DefaultNamingContext をクリックしてから、編集 をクリックします。
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7 ストリング属性エディタ の 値 テキストボックスで、 CN=nfsadldsinstance, dc=server1 と入力し、OK をクリックします。
8 ADSI エディタ を閉じます。

Active Directory スキーマのアップデート
Active Directory スキーマをアップデートするには次の手順を実行します。

1 タスクバーで スタート をクリックし、検索ボックスに cmd と入力します。
2 Command Prompt を右クリックし、Run as administrator を選択します。
3 C:\WINDOWS\ADAM ディレクトリに移動し、次のコマンドを入力します。

regsvr32 schmmgmt.dll

このコマンドは Active Directory プラグイン schmmgmt.dll を有効化します。
4 スタート をクリックし、実行 と入力します。
5 ［Run］ダイアログを開き、MMC と入力して Microsoft 管理コンソール（MMC）を起動します。
6 ［Console］ウィンドウで、File > Add/Remove Snap-in の順に選択します。
7 スナップインの追加と削除 ダイアログボックスで、Active Directory スキーマ をクリックします。
8 追加 をクリックし、次に OK をクリックします。
9 Active Directory スキーマ ノードを右クリックし、次に Active Directory ドメインコントローラの変更 をクリックして、以前に作成された AD LDS 

インスタンスに接続します。

注意: クリックして（右クリックではなく）エラーが発生した場合、MMC を再起動する必要があります。右クリックの代わりに間違っ
てクリックした場合、これらの手順は機能しません。

10 ディレクトリサーバーの変更 ダイアログボックスの 次へ変更 で、This Domain Controller AD LDS instance（このドメインコントローラの AD LDS 
インスタンス）をクリックします。

11 名前 列で、プレースホルダテキスト <ここにディレクトリサーバー名[:ポート]を入力> をサーバーおよびポート番号（例：localhost:389）
に書き換えます。

メモ: この情報を入力したら <Enter> を押します（またはテキストをダブルクリックします）。<Enter> を押さないと、OK ボタンが表示
されません。

12 OK をクリックします。
13 gidNumber および uidNumber 属性を、次のようにユーザークラスに追加します。

a Active Directory スキーマ ノードを展開して、クラス ノードを展開し、ユーザー を右クリックして プロパティ をクリックします。
b プロパティ ダイアログボックスで、属性 タブをクリックします。
c 追加 をクリックして スキーマオブジェクトの選択 ダイアログボックスを開きます。
d gidNumber をクリックして、OK をクリックします。
e 追加 をクリックして スキーマオブジェクトの選択 ダイアログボックスを開きます。
f uidNumber をクリックして、OK をクリックします。
g OK をクリックします。

注意: ユーザー を右クリックの代わりに間違って左クリックすると、手順 g の実行後にエラーを受け取りもう一度やり直す必要があり
ます。これを防ぐには、右クリックするか、Active Directory スキーマノードまで戻ってクリックし、手順 a を繰り返します。

14 次の手順を実行して、gidNumber 属性をグループクラスに追加します。
a Active Directory スキーマ ノード、および クラス ノードを展開します。
b グループ を右クリックし、プロパティ をクリックします。
c グループの プロパティ ダイアログボックスで、属性 タブをクリックします。
d 追加 をクリックして スキーマオブジェクトの選択 ダイアログボックスを開きます。
e gidNumber をクリックして、OK をクリックします。
f OK をクリックします。
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15 MMC を終了し、保存 をクリックします。

UNIX ベース システムから Windows ベース システムへのユ
ーザーおよびグループ アカウント マップの追加
このセクションでは、Windows ベース システムにユーザーおよびグループ アカウント マップを追加するために必要な次の手順について説明します。

• 識別名またはネーミング コンテキストへの接続：デフォルトのネーミング コンテキストの設定、UNIX から Windows オペレーティング システムへアカウン
ト マッピングを保持するためのコンテナの作成。

• ユーザー アカウント マップの追加：uidNumber、gidNumber、および sAMAccountName 属性をマップして、CN=Users コンテナにユーザークラス 
オブジェクトを作成します。

• グループ アカウント マップの追加：CN=Users コンテナにグループクラス オブジェクトを作成して、gidNumber および sAMAccountName 属性をマッ
プします。

識別名、またはネーミングコンテキストへの接続
識別名、ネーミングコンテキストに接続するには、次の手順を実行します。

1 Server Manager で、Tools > ADSI Edit の順にクリックします。
ADSI エディタ コンソールが表示されます。

2 コンソールで ADSI エディタ を右クリックして 接続 をクリックします。
または、ADSI Edit コンソールで、Actions > More Actions > Connect to と移動することもできます。

接続の設定 ダイアログボックスが表示されます。
3 接続ポイント で、既知のネーミングコンテキストを選択する オプションを選択します。

デフォルトで、デフォルトのネーミングコンテキスト オプションがドロップダウンメニューから選択されています。
4 コンピュータ で ドメインまたはサーバーを選択または入力 オプションを選択し、テキストボックスにコロンで区切られたサーバー名とポート番号（例

えば localhost:389）を入力します。
5 OK をクリックします。

ADSI エディタ が更新され、新規接続が表示されます。
6 結果ツリーの デフォルトのネーミングコンテキスト ノードで、パーティション名を右クリックし、新規 をクリックしてから オブジェクト をクリックします。

メモ: 例えば、デフォルトのネーミングコンテキスト localhost:389 では、次のプロパティ： CN=nfsadldsinstance，
DC=server1 を選択します。

7 オブジェクトの作成 ダイアログボックスで、コンテナ クラスを選択し、次へ をクリックします。
8 値 ボックスで Users を入力し、次へ をクリックします。

この値は、ユーザーアカウントマッピングを保持するために使用されるコンテナオブジェクトの名前を指定します。
9 終了 をクリックします。

ユーザーアカウントマップの追加
ユーザーアカウントマップを追加するには、次の手順を実行します。

1 ADSI 編集 で デフォルトのネーミングコンテキスト ノードを展開してから、パーティション名を展開します。
2 CN=Users を右クリックし、 新規 をクリックして オブジェクトをクリックします。
3 オブジェクトの作成 ダイアログボックスで ユーザー クラスを選択し、次へ をクリックします。
4 値 テキストボックスでユーザー名を入力し、次へ をクリックします。
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メモ: ユーザー名は Windows または UNIX ユーザーとは関連しておらず、ランダムに入力できます。
5 追加の属性 ボタンをクリックし、このユーザーアカウントの uidNumber、gidNumber、および sAMAccountName 属性を編集します。

メモ: uidNumber および gidNumber はマップされている UNIX ユーザーの UID と GID を表し、sAMAccountName は NFS 用サ
ーバーを実行しているコンピュータのローカル Windows ユーザーの名前と一致する必要があります。追加の属性ボタンの選択後、
uidNumber および gidNumber が表示されない場合は、ADSI エディタ MMC を閉じて開きます。

6 OK をクリックします。

グループアカウントマップの追加
グループアカウントマップを追加するには、次の手順を実行します。

1 ADSI エディタ で デフォルトの名前付けコンテキスト ノードを展開し、パーティション名を展開します。
2 CN=Users を右クリックし、新規 をポイントしてから オブジェクト をクリックします。
3 オブジェクトの作成 ダイアログボックスで、グループ クラスを選択し、次へ をクリックします。

メモ: グループオブジェクトの名前が、グループアカウントマッピングが必要なグループアカウント名と一致することを確認してくださ
い。

4 新規グループオブジェクトの gidNumber および sAMAccountName 属性を設定します。

メモ: gidNumber はマップされている UNIX グループの GID であり、sAMAccountName は NFS 用サーバーを実行している 
Windows ベースコンピュータ上のローカルグループの名前と一致している必要があります。追加の属性 ボタンの選択後、
uidNumber および gidNumber が表示されない場合は、ADSI エディタ MMC を閉じて開きます。

5 OK をクリックして、終了 をクリックしウィザードを閉じます。

ADS LDS ネームスペース オブジェクトへのアクセスの承認
ネームスペース オブジェクトへのアクセス権を付与するには、次の手順を実行します。

1 タスクバーで スタート をクリックし、検索ボックスに cmd と入力します。
2 Command Prompt を右クリックし、Run as administrator を選択します。
3 C:\WINDOWS\ADAM ディレクトリに移動し、次のように dsacls コマンドを実行して 全員 グループにマッピングデータストアへの読み取りアクセス許

可を付与します。
dsacls "\\server1:389\CN=nfsadldsinstance,dc=server1" /G everyone:GR /I:T

4 オプションとして、複数の NFS サーバーがアカウントマッピングにクエリを行う許可をするため、共有 AD LDS ストアを設定する場合、マッピングデータ
ストアを ACL に追加して、次のように匿名ログオンアカウントに読み取りアクセス許可を付与します。
dsacls "\\server1:389\CN=nfsadldsinstance,dc=server1" /G "anonymous logon":GR /I:T

メモ: コンピュータからマッピングデータストア間に共有アクセスがない場合は、この手順を省略できます。

マッピングソースの設定
マッピングソースを設定するには、次の手順を実行します。

1 タスクバーで、Start をクリックし、検索ボックスに cmd と入力します。
2 Command Prompt を右クリックし、Run as administrator を選択します。
3 <Computer> が AD LDS インスタンスが作成されたコンピュータの名前で、<Port> が AD LDS インスタンスの使用するポートである次のコマンドを

実行します。
nfsadmin mapping config adlookup=yes addomain=<Computer>:<Port>
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メモ: たとえば、次のコマンドを入力します。
nfsadmin mapping config adlookup=yes addomain=server1:389

4 NFS リソースにアクセスし、ユーザーおよびグループアカウントマッピングが期待通りに作動することを確認して、設定をテストします。

NFS アカウントマッピング問題のためのデバッグメモ
次のレジストリキーを設定することによって、NFS 用のサーバーがアカウントマッピング障害を Windows Event Log サービスにログするようにすることが可
能です。
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\nfsserver\Parameters
\VerboseMappingFailureLogging INVALID USE OF SYMBOLS REG_DWORD = 1

このキーを作成した後は、NFS 用のサーバーを再起動する必要があります。

NFS 用のサーバー再起動
NFS 用のサーバーを再起動するには、次の手順を実行します。

1 タスクバーで スタート をクリックし、検索ボックスに cmd と入力します。
2 Command Prompt を右クリックし、Run as administrator を選択します。
3 次のコマンドを実行します。

nfsadmin server stop && nfsadmin server start

NFS 共有の作成
NFS 共有 を作成するには次の手順を実行します。

1 サーバーマネージャー ウィンドウで ファイルサービスと記憶域サービス サーバー役割に進み、共有 をクリックします。
共有、ボリューム および クォータ ペインがあるページが表示されます。

2 新しい共有を作成するには、共有セクションで次の手順のいずれかを実行します。
• 共有ファイルの作成に、新しい共有ウィザードを起動 リンクをクリックします。
• タスク ドロップダウンメニューから 新しい共有 を選択します。

新しい共有ウィザード ウィンドウが表示されます。
3 この共有のプロファイルの選択 ページで、要件に応じて ファイル共有プロファイル（NFS 共有 – 簡易または詳細） を選択し、次へ をクリックし

ます。
4 この共有のサーバーとパスの選択 ウィンドウで、新しい共有の サーバー名 および 共有の場所 を選択し、次へ をクリックします。

共有の場所はボリューム、またはカスタムパスを入力することで選択できます。
5 共有名の指定 ウィンドウで、共有名 および 共有の説明 を入力し、次へ をクリックします。

共有フォルダが存在しない場合は、共有へのローカルパスがフォルダを自動的に作成します。
6 認証方法の指定 ウィンドウで、NFS 共有の認証方法を選択し、 次へ をクリックします。

メモ: NFS へのアクセス権があるのは UNIX ユーザー（ドメインユーザーリストに追加済み）のみです。NFS 共有に匿名アクセスを
有効化した場合、UNIX ユーザー全員が共有にアクセスできます。

7 共有設定の構成 ウィンドウで必要な設定を選択し、次へ をクリックします。
8 アクセスを制御するアクセス許可の指定 ウィンドウでファイル共有のアクセス許可を設定し、次へ をクリックします。
9 必要に応じてあらゆる組み合わせのフォルダアクセス許可を設定し、次へ をクリックします。
10 選択内容の確認 ウィンドウで設定を確認し、作成 をクリックします。

共有の正常な作成を示す 結果の表示 ウィンドウが表示されます。
11 閉じる をクリックしてウィザードを終了します。
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ファイル サーバ リソース マネージャーを使用したクォータの
作成
ファイル サーバ リソース マネージャーツールを使用してクォータを作成します。

1 Server Manager で、Tools > File Server Resource Manager の順にクリックします。
ファイルサーバーリソースマネージャ コンソールが表示されます。

2 Quota Management をダブルクリックして、Quotas フォルダーと Quota Template を表示します。
3 Quotas フォルダーをダブルクリックして、次のいずれかを実行します。

• Quotas フォルダーを右クリックして、Create Quota を選択します。
• Actions ペインから Create Quota を選択します。

4 画面の指示に従って、パス（クォータを作成するボリュームまたはフォルダ）を選択し、 希望する クォータのプロパティ を設定して 作成 をクリックし
ます。
新しく作成されたクォータが中央のペインに表示されます。

ファイル サーバ リソース マネージャーを使用したファイル ス
クリーンの作成
File Server Resource Manager ツールを使用して、ファイル スクリーンを作成します。

1 Server Manager で、Tools > File Server Resource Manager の順にクリックします。
ファイルサーバーリソースマネージャ コンソールが表示されます。

2 File Screening Management をダブルクリックします。
3 File Screens フォルダーをダブルクリックして、次のいずれかの操作を行います。

• Create File Screen フォルダを右クリックして、Create File Screen を選択します。
• Actions ペインから Create File Screen を選択します。

4 画面の指示に従って、パス（ファイルスクリーンを作成するボリュームまたはフォルダ）を選択し、 希望する ファイルスクリーンのプロパティ を選択して 
作成 をクリックします。
新しく作成されたファイルスクリーンが作業中のペインに表示されます。

5 既存のファイルスクリーンのいずれかを選択し、右クリックするか、または右のペインにあるオプションを使って、ファイルスクリーンのプロパティを変更しま
す。

新規ボリュームの作成
新しいボリュームを作成するには、次の手順を実行します。
このタスクについて

メモ: 新しいボリュームを作成するには、バックアップ オペレーターまたは管理者権限が必要です。

手順
1 サーバーマネージャー で、ファイルサービスと記憶域サービス のサーバー役割をクリックし、ボリューム を選択します。
2 タスク ドロップダウンメニューからの ボリューム ペインで、新しいボリューム を選択します。

新しいボリュームウィザード ウィンドウが表示されます。
3 ボリュームの作成先のサーバとボリュームを選択します。
4 ウィザードに表示される手順に従って、次のパラメーターを設定します。

• ボリューム サイズ
• ドライブ レター
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• ファイル システムのタイプ
• ボリューム ラベル
• フォーマット オプション
• データ重複排除

5 ボリューム作成設定を確認し、作成 をクリックします。
新しいボリュームが Volumes ペインに表示されます。

ボリュームの管理
ディスクの管理はディスクおよびボリュームの管理に使用されます。ディスクの管理にアクセスするには、サーバ マネージャーを起動し、［ツール］メニューで
［コンピューターの管理］ > ［ストレージ］ > ［ディスクの管理］の順にクリックします。

• ディスクの管理を使用して、ディスクの初期化、ボリュームの作成、および FAT、FAT32、または NTFS ファイルシステムでのボリュームのフォーマットを
行うことができます。

• ディスクの管理では、システムを再起動したり、ユーザーの操作を中断することなく、ほとんどのディスク関連タスクを実行することができます。

ボリュームの拡張
既存のプライマリパーティションと論理ドライブには、同じディスク上にある隣接する未割り当て容量にこれらを拡張することによって容量を追加することが
できます。ベーシックボリュームを拡張するには、これが raw ボリュームであるか、NTFS ファイルシステムでフォーマットされている必要があります。

Windows インタフェースを使用したベーシックボリュームの拡張
Windows インタフェースを使用してベーシックボリュームを拡張するには次の手順を実行します。
前提条件

メモ: ディスクに未割り当て領域がない場合、ボリュームを拡張する前に Dell OpenManage Server Administrator を使用して LUN を拡張
します。

手順
1 Server Manager を起動し、Tools メニューから、Computer Management > Storage > Disk Management の順にクリックします。
2 ディスクの管理 で、拡張する ベーシックボリューム を右クリックします。
3 ボリュームの拡張 をクリックします。

ボリュームの拡張ウィザード ウィンドウが表示されます。
4 画面上のタスクを完了し、ディスクを選択してディスク容量を入力し、ウィザードを閉じます。

CLI を使用したベーシックボリュームの拡張
CLI を使用してベーシックボリュームを拡張するには次の手順を実行します。

1 CLI ウィンドウを開き、 diskpart と入力します。
2 DISKPART プロンプトで、list volume と入力します。
3 拡張するベーシックボリュームを書き留めます。
4 DISKPART プロンプトで次を実行します。

a select volume <ボリュームの番号> と入力して、同じディスク上の連続した空き容量に拡張するベーシックボリュームの番号を選択しま
す。

b extend [size=<サイズ>] と入力して、選択したボリュームをメガバイト（MB）単位で拡張します。
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ボリュームの縮小
プライマリ パーティションおよび論理ドライブによって使用される容量は、同じディスク上の隣接する連続した容量内に縮小することで削減することができま
す。例えば、追加パーティションが必要でも追加ディスクがないという場合、ボリュームの終りにある既存パーティションを縮小して、新規パーティション用に
使用できる新しい未割り当ての容量を作成することができます。ボリュームを縮小するには、次の手順を実行します。

1 Server Manager を起動して、Tools メニューから、Computer Management > Storage > Disk Management の順に選択します。
2 ディスクの管理 で、縮小する ベーシックボリューム を右クリックします。
3 ボリュームの縮小 をクリックします。

<ボリューム名>の縮小 ウィンドウが表示されます。
4 画面の指示に従って、縮小 をクリックします。

メモ: 縮小できるのは、ファイルシステムがない、または NTFS ファイルシステムを使用するベーシックボリュームのみです。

ボリュームを縮小する際の追加注意事項
• パーティションを圧縮する場合、移動できないファイル（ページファイルまたはシャドウコピーストレージ領域など）は自動的に再配置されず、移動でき

ないファイルが配置されている位置以上に割り当てられた容量を削減することはできません。
• 不良クラスタの動的再マップによって検出された不良クラスタの数が多い場合は、パーティションを圧縮できません。この状態が発生した場合、データ

を移動してディスクを交換することを検討する必要があります。
• ブロックレベルのコピーを使用してデータを転送しないでください。この方法では不良セクタのテーブルもコピーされるので、新しいディスクでは、同一の

セクタが正常であっても不良セクタとして扱われます。
• 圧縮できるのは、プライマリパーティションと未加工のパーティション（ファイル システムがないもの）にある論理ドライブ、または NTFS ファイルシステム

を使用しているパーティションです。

ボリュームの削除
ボリュームを削除するには、次の手順を実行します。
前提条件

注意: ボリュームを削除する前に、ボリュームから共有およびシャドーコピーのすべてを削除する必要があります。ボリュームの共有すべてが削
除される前にそのボリュームを削除すると、サーバーマネージャーが共有を正しく表示しない可能性があります。

手順
1 Server Manager を起動し、Tools メニューから、Computer Management > Storage > Disk Management の順にクリックします。
2 ディスクの管理 で削除する ボリューム を右クリックし、ボリュームの削除 オプションを選択します。

シンプルボリュームの削除 確認ウィンドウが表示されます。
3 確認画面で はい を選択し、ボリュームを削除します。

ボリュームを削除する際の追加情報
ディスク管理の追加機能は次のとおりです。

よりシンプルなパーテ
ィション作成

ボリュームを右クリックすると、ベーシック、スパン、またはストライプのどのパーティションを作成するかをメニューから直接選択する
ことができます。

ディスク変換オプショ
ン

ベーシックディスクに 4 つを越えるパーティションを追加すると、ディスクをダイナミックまたは GUID パーティションテーブル（GPT）
パーティションスタイルに変換するプロンプトが表示されます。
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パーティションの拡張
と圧縮

Windows インタフェースからパーティションを直接拡張および圧縮することができます。

データ重複排除
データ重複排除は、サブファイル レベルで機能し、小さなチャンクへファイルをセグメント化することで、より少ない容量でより多くのデータを保存します。こ
の機能は、重複データを識別し、各データ チャンクの単一コピーを維持します。ファイルは圧縮され、システム ボリューム情報フォルダー内の特別なコンテ
ナ ファイルに分類されます。

ボリュームを重複排除向けに有効化し、データを最適化した後、ボリュームには未最適化ファイル、最適化済みファイル、チャンクストア、および追加の空
き容量が含まれます。
Windows Storage Server のデータ重複排除は、仮想デスクトップ インフラストラクチャ（VDI）の展開で最適化されたリモート ストレージをサポートしま
す。VDI でのデータ重複排除は、ストレージ サブシステムの IO パフォーマンスを向上させ、その結果、一般的なファイル サーバと VDI ストレージでの既存
サブシステムの利用率が上がります。

メモ: データ重複排除は、Windows Storage Server 2008 で使用された SIS（シングル インスタンス ストレージ）を置き換えます。初めてデ
ータ重複排除を使用する場合、または SIS を使用している環境から移行する場合の詳細については、technet.microsoft.com/en-us/

library/hh831454.aspx にあるデータ重複排除の相互運用性のセクションを参照してください。

メモ: サーバのセットアップ、データ重複排除の有効化、およびボリュームの最適化を行うには、technet.microsoft.com/en-us/library/

hh831434.aspx にあるデータ重複排除のインストールと設定のセクションを参照してください。

共有フォルダのシャドウコピーの有効化および設定
シャドウ コピーは、共有フォルダーの以前の内容を表示するために使用されます。デフォルト値を使用してボリューム上にある共有フォルダーのシャドウ コ
ピーを有効化した場合、午前 7 時、および正午にシャドウ コピーを作成するようにタスクがスケジュールされます。デフォルトのストレージ領域は同じボリュ
ーム上にあり、そのサイズは使用可能容量の 10 パーセントです。
このタスクについて
共有フォルダの シャドウコピー は、ボリューム単位でしか有効化できません。ボリューム上でコピーする、またはコピーしない特定の共有フォルダおよびファイ
ルを選択することはできません。

メモ: シャドウコピーの作成は通常のバックアップを作成する代替にはなりません。

注意: ボリュームごとのシャドウコピーは 64 コピーに制限されています。この上限に到達、またはストレージ領域制限に到達すると、最も古いシ
ャドウコピーが削除されます。シャドウコピーが削除されると、そのシャドーコピーを回復することはできません。

手順
1 Server Manager を起動します。
2 Tools メニューから、Computer Management > Storage > Disk Management の順にクリックします。

ストレージコンソールの中央ペインに、システム上のボリュームのリストが表示されます。
3 ボリュームを右クリックして、プロパティ を選択します。

選択された <ボリューム> のプロパティウィンドウが表示されます。
4 Shadow Copies（シャドウコピー）タブをクリックします。

5 共有フォルダの シャドウコピー を有効にするボリュームを選択し、有効 をクリックします。
6 今すぐ作成 をクリックして、選択したボリュームのシャドウコピーを作成します。
7 ストレージの場所、容量の割り当て、およびスケジュールを変更するには、設定 をクリックします。

サーバのバックアップの実行
Windows Server バックアップは、お使いのシステムに取り付けられているサーバのための基本的なバックアップおよびリカバリ タスクを実行するツール一
式とウィザードを提供する機能です。ローカルまたはオンラインの場所にデータをバックアップできます。
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前提条件
お使いのシステムに Windows Server バックアップをインストールするには、次の手順を実行します。
手順
1 サーバーマネージャーを起動し、管理 メニューから、 役割と機能の追加 を選択します。

役割と機能の追加ウィザード が表示されます。
2 Add Roles and Features Wizard の画面の指示に従って、Select features ダイアログ ボックスで、Windows Server Backup チェックボックスを

選択し、Next をクリックします。
3 インストールする機能を確認し、インストール をクリックします。

お使いのコンピュータに Windows Server バックアップ 機能がインストールされました。
4 Windows Server バックアップにアクセスするには、Server Manager を起動し、次のいずれかを実行します。

• Tools メニューから、Windows Server Backup を選択します。
• Tools メニューから Computer Management > Storage > Windows Server Backup の順に選択します。

Windows Server バックアップ コンソールがウィンドウの作業中のペインに表示されます。

次のバックアップオプションが利用可能です。
• ローカル バックアップ — お使いのシステムで Backup Schedule Wizard、または Backup Once Wizard を使用して、単発バックアップを実行

するか、定例バックアップの予定を決めます。

メモ: Windows Server Backup で、Recovery Wizard を使用して、以前に作成されたバックアップからファイル、アプリケー
ション、ボリューム、またはシステム状態を復元します。

• オンライン バックアップ — オンライン バックアップを実行するには、お使いのシステムを Windows Azure オンライン バックアップに登録します。詳
細については、technet.microsoft.com/en-us/library/hh831419.aspx にアクセスしてください。

バックアップするボリュームの選択
バックアップを作成するには、それに含めるボリュームを指定してください。選択するボリュームは回復できる内容に影響します。ボリュームおよび回復のオプ
ションは次のとおりです。

ボリュームオプショ
ン

回復オプション

全サーバー（すべての
ボリューム）

全サーバー（すべてのファイル、データ、アプリケーションおよびシステム状態）を回復したい場合は、すべてのボリュームをバック
アップします。

重要なボリューム OS またはシステム状態のみを回復できるようにしたいときに、重要なボリューム（OS ファイルを含むボリューム）をバックアップし
ます。

重要でないボリューム ボリュームからファイル、アプリケーション、またはデータのみを回復できるようにしたいときに、個々のボリュームをバックアップしま
す。

保存場所の選択
バックアップ用のストレージの場所を選択する場合、次のストレージ タイプの詳細を考慮してください。

ストレージタイプ 詳細
共有フォルダ リモート共有フォルダにバックアップを保存する場合、そのバックアップは新しいバックアップが作成されるたびに上書きされます。

一連のバックアップを保存したい場合は、このオプションを選択しないでください。
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ストレージタイプ 詳細
バックアップがすでに存在する共有フォルダにバックアップを作成しようとしている最中にバックアッププロセスが失敗すると、バック
アップが全くない状態になる場合があります。この問題を回避するには、バックアップを保存するために、共有フォルダ内にサブフ
ォルダを作成することができます。

DVD、その他の光学
メディア、またはリムー
バブルメディア

バックアップを光学、またはリムーバブルメディアに保存する場合、回復できるのはボリューム全体のみで、アプリケーションや個
々のファイルを回復することはできません。さらに、空き容量が 1 GB 未満のメディアへのバックアップはサポートされていません。

ローカルハードディス
ク

バックアップを内蔵ハードディスクに保存すると、次が可能になります。

• ファイル、フォルダ、アプリケーションおよびボリュームの回復。
• 使用するバックアップに重要なボリュームすべてが含まれている場合、システム状態およびオペレーティングシステムのリカバリ

を実行。

ただし、ひとつ、または複数の重要なボリュームが存在する物理ディスクと同じディスクにバックアップがあると、OS のリカバリは実
行できません。

また、選択したローカルディスクが定期的バックアップの保存専用になっており、Windows Explorer で表示されない場合も同じ
です。

外付けハードディスク バックアップを外付けハードディスクに保存すると、次が可能になります。

• ファイル、フォルダ、アプリケーションおよびボリュームの回復。
• 使用するバックアップに重要なボリュームすべてが含まれている場合、システム状態およびオペレーティングシステムのリカバリ

を実行。
• 防災のため、バックアップを現場外に簡単に移動。

定期的バックアップを外付けハードディスクに保存すると、ディスクはバックアップ保存専用になり、Windows Explore には表示
されません。

外付けハード ディスクを使用することにより、災害からの保護用にディスクをオフサイトに移動し、バックアップの整合性を確保す
ることができます。

NIC チーミング
LBFO（ロード バランシング/フェールオーバー）とも呼ばれる NIC チーミングは、Windows Storage Server 2016 の組み込み機能です。この機能は、ネ
ットワーク アダプタのフォールト トレランスを可能にします。NIC チーミングでは、複数のネットワーク アダプタをチームとして連携させることができ、1 個の
NIC に不具合が発生しても接続が失われることはありません。

組み込み NIC チーミングの利点は、すべての NIC で機能し、すべてのアダプタに管理ツール一式を提供することです。アウトバウンドトラフィックは、ネット
ワークトラフィックの分散のための スイッチ非依存モード と スイッチ依存モード を使用することによって、利用可能なネットワークアダプタ全体に分散させ
ることができます。

サーバーでの NIC チーミングの設定
サーバで NIC チーミングを設定するには、次の手順を実行します。
このタスクについて

メモ: Broadcom NIC が検出されたときは Broadcom Advanced Control Suite（BACS）、Intel NIC が検出されたときは Intel PROSet ドラ
イバがインストールされます。
メモ: Microsoft では、サーバーマネージャー に組み込まれた NIC チーミング機能を使用することをお勧めします。
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手順
1 サーバーマネージャーを起動し、ローカルサーバーを選択します。

ローカルサーバーのプロパティが表示されます。
2 NIC チーミングの横にあるステータスをクリックします。

NIC チーミング ウィンドウが表示されます。
3 アダプターとインタフェース セクションに、チーミングできる利用可能なアダプタのリストが表示されます。
4 チームに追加するアダプタを選択します。右クリックして 新しいチームに追加 を選択します。
5 NIC チーミング ウィンドウで、追加するアダプタ用の チーム名 ボックスにチーム名を入力します。
6 追加のプロパティ で、チーミングモード、負荷分散モード、スタンバイアダプタ を選択し、OK をクリックします。

新しく作成された NIC チームが同じウィンドウの チーム セクションに表示されます。
7 NIC チームの作成と設定後、Open Network and sharing Center > Change Adapter Settings と進みます

新しく作成された NIC チームがこのウィンドウに表示されます。
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ヘルプ
本項では、Dell EMC テクニカル サポートに連絡する方法、システムの QR コードを使用して情報にアクセスする方法、および Dell EMC で使用できるド
キュメント リソースに関する情報を提供します。

Dell EMC へのお問い合わせ
Dell EMC では、オンラインおよび電話によるサポートとサービス オプションをいくつかご用意しています。アクティブなインターネット接続がない場合は、ご購
入時の納品書、出荷伝票、請求書、またはデル製品カタログで連絡先をご確認いただけます。これらのサービスは国および製品によって異なり、お住ま
いの地域では一部のサービスがご利用いただけない場合があります。販売、テクニカルサポート、またはカスタマーサービスの問題に関する Dell EMC への
お問い合わせに関しては、次の手順を実行してください。

1 Dell.com/Support/Home に移動します。
2 お住まいの国を、ページ右下隅のドロップダウンメニューから選択します。
3 カスタマイズされたサポートを利用するには、次の手順に従います。

a ［サービスタグの入力］フィールドに、お使いのシステムのサービスタグを入力します。
b Submit（送信） をクリックします。

さまざまなサポートのカテゴリをリストアップしているサポートページが表示されます。
4 一般的なサポートを利用するには、次の手順に従います。

a product category（製品カテゴリ）を選択します。
b product segment（製品セグメント）を選択します。
c product（製品）を選択します。

さまざまなサポートのカテゴリをリストアップしているサポートページが表示されます。
5 Dell EMC グローバルテクニカルサポートへのお問い合わせ先詳細：

a Dell.com/support/incidents-online に移動します。
b ［テクニカル サポートに連絡］ページには、Dell EMC グローバル テクニカル サポート チームへの電話、チャット、または電子メール送信のため

の詳細が記載されています。

システムサービスタグの位置
固有のエクスプレス サービス コードおよびサービスタグを使用して、お使いのシステムを識別することができます。システム前面の情報タグを引き出すと、エ
クスプレス サービス コードおよびサービスタグを確認できます。または、システムのシャーシに貼られたシールに情報が記載されている場合があります。この
情報は、サポート センターへいただいたお電話を適切な担当者に繋ぐためにデルで使用されます。

QRL によるシステム情報へのアクセス
Quick Resource Locator（QRL）を使用すると、お使いのシステムに関する情報にすぐにアクセスできます。QRL はシステム カバーの上部にあり、お使
いのシステムに関する一般的な情報にアクセスできます。構成や保証など、お使いのシステム特有の情報を確認するには、システム情報タグにある QR
コードにアクセスしてください。
前提条件
お使いのスマートフォンまたはタブレットに QR コード スキャナーがインストールされていることを確認します。
QRL には、お使いのシステムに関する次の情報が含まれています。

• ハウツービデオ
• 設置およびサービス マニュアル、LCD 診断、機械的概要などの参照資料

5
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• テクニカル サポートや営業チームへのお問い合わせのための Dell EMC への直接的なリンク

手順
1 www.Dell.com/QRL にアクセスして、お使いの製品に移動する、または
2 お使いのスマートフォンまたはタブレットを使用して、お使いのシステムにある QR（Quick Resource）コードをスキャンするか、または次の QR コード

を使用します。

図 1. NX3340 の QR コード

図 2. NX3240 の QR コード

図 3. NX440 の QR コード

ドライバとファームウェアのダウンロード
Dell EMC では、お使いのシステムに最新の BIOS、ドライバ、システム管理ファームウェアをダウンロードしてインストールすることを推奨しています。 
前提条件
ドライバとファームウェアをダウンロードする前に、ウェブブラウザのキャッシュをクリアするようにしてください。
手順
1 www.dell.com/support/drivers にアクセスします。
2 Drivers & Downloads（ドライバおよびダウンロード）セクションで、Service Tag or Express Service Code（サービスタグまたはエクスプレスサー

ビスコード）ボックスにお使いのシステムのサービスタグを入力し、Submit（送信）をクリックします。

メモ: サービスタグがない場合は、Detect My Product（製品の検出）を選択してシステムにサービスタグを自動的に検出させるか、
製品サポートでお使いの製品を選択します。

3 Drivers & Downloads（ドライバおよびダウンロード）をクリックします。
ユーザーの選択した項目に該当するドライバが表示されます。
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4 ドライバを USB ドライブ、CD、または DVD にダウンロードします。

マニュアルリソース
本項では、お使いのシステムのマニュアルリソースに関する情報を提供します。

タスク 文書 場所

システムのセットアップ ラックへのシステムの取り付けについての情報は、お使い
のラックソリューションに同梱のラックマニュアルを参照して
ください。

www.dell.com/storagemanuals

システムの起動と技術的仕様の詳細については、システ
ムに同梱の『はじめに』マニュアルを参照してください。

ストレージ システム、および内蔵ストレージの設定手順
の情報については、Setting up Your Dell Storage 

Network Attached Storage System を参照してくださ
い。

システムの設定 システムの設定、管理、アップデート、および復元の詳
細については、『Dell EMC Network Attached 
Storage System using Windows Storage Server 

2016 Administrator's Guide』を参照してください。

www.dell.com/storagemanuals

iDRAC 機能、iDRAC の設定と iDRAC へのログイン、お
よびシステムのリモート管理についての情報は、
『Integrated Dell Remote Access Controller User's 

Guide』（Integrated Dell Remote Access Controller 

ユーザーズガイド）を参照してください。

www.dell.com/idracmanuals

Remote Access Controller Admin（RACADM）サブ
コマンドとサポートされている RACADM インタフェースを
理解するための情報は、『RACADM Command Line 

Reference Guide for iDRAC』（iDRAC のための 
RACADM コマンドライン参照ガイド）を参照してくださ
い。

www.dell.com/idracmanuals

ドライバおよびファームウェアのアップデートの詳細につい
ては、右記の URL を参照してください。

www.dell.com/support/drivers

システムのトラブルシューティング ハードウェアに関する問題のトラブルシューティングの詳
細については、『Dell EMC Network Attached 
Storage Systems using Windows Storage Server 

2016 Troubleshooting Guide』を参照してください。

www.dell.com/storagemanuals

システムの管理 Dell OpenManage Systems Management の機能に
ついての情報は、『Dell OpenManage Systems 

Management Overview Guide』（Dell OpenManage 

Systems Management 概要ガイド）を参照してくださ
い。

www.dell.com/openmanagemanuals ＞
OpenManage Essentials

OpenManage のセットアップ、使用、およびトラブルシュ
ーティングについての情報は、『Dell OpenManage 

Server Administrator User’s Guide』（Dell 

OpenManage Server Administrator ユーザーズガイ
ド）を参照してください。

www.dell.com/openmanagemanuals ＞
OpenManage Server Administrator
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Dell OpenManage Essentials のインストール、使用、
およびトラブルシューティングについての情報は、『Dell 

OpenManage Essentials User’s Guide』（Dell 

OpenManage Essentials ユーザーズガイド）を参照して
ください。

www.dell.com/openmanagemanuals ＞
OpenManage Essentials

Dell System E-Support Tool（DSET）のインストール
と使用についての情報は、『Dell System E-Support 

Tool（DSET）User's Guide』（Dell System E-Support 

Tool（DSET）ユーザーズガイド）を参照してください。

www.dell.com/DSET

Dell Lifecycle Controller の機能の詳細については、
『Dell Lifecycle Controller ユーザーズ ガイド』を参照し
てください。

www.dell.com/idracmanuals

エンタープライズ システム管理パートナー プログラムの詳
細については、『OpenManage Connections 

Enterprise Systems Management』マニュアルを参照
してください。

www.dell.com/
omconnectionsenterprisesystemsmanagement

接続およびクライアントシステム管理についての情報は、
OpenManage Connections Client Systems 

Management マニュアルを参照してください。

www.dell.com/dellclientcommandsuitemanuals

Dell EMC PowerEdge RAID コン
トローラの操作

Dell PowerEdge RAID コントローラ（PERC）の機能を
理解し、PERC カードを導入するための情報は、ストレ
ージコントローラのマニュアルを参照してください。

www.dell.com/storagecontrollermanuals

イベントおよびエラーメッセージの
理解

システム ファームウェア、およびシステム コンポーネントを
監視するエージェントによって生成されたイベント メッセ
ージとエラー メッセージのチェックの詳細については、第
14世代 Dell EMC PowerEdge サーバーのイベントおよ
びエラー メッセージ リファレンス ガイドを参照してくださ
い。

www.dell.com/openmanagemanuals ＞
OpenManage Software

マニュアルのフィードバック
任意の Dell EMC ドキュメント ページでドキュメントを評価するかフィードバックを書き、［フィードバックの送信］をクリックしてフィードバックを送信すること
ができます。
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